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About this document 

Scope and purpose 

The purpose of this document is to provide a comprehensive and easy to follow guide of the 

PowIRCenter software. The scope applies to all the aspects of the software from installation to 

troubleshooting. 

Intended audience

DC/DC power supply designers using the PowIRCenter software to program Infineon digital IC’s 
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1 PowIRCenter Features  

• Control and monitor up to 20 devices. 

• Supports Acadia, Baxter, Comanche, Lucas, Katahdin, Manhattan, Rocky, and Salem family devices. 

• Automatic dongle firmware update. 

• Dedicated screens for 

o PMBus commands and summary 

o System status : Vin, Iin, Vout, Iout, Vcc, Temperature 

o Register Map 

o Group Vout Control: Margin High, Margin Low, and On/Off 

o Sequencing : On/Off delay, rise time, fall time 

o Multiple-device programmer 

o Design Wizards 
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2 System Requirements

• Ensure that you are connected to the internet. 

• Microsoft .NET Framework 4.0 must be installed. This can be downloaded here (if the link does not work, 

paste “http://www.microsoft.com/en-us/download/details.aspx?id=17718” without the quotes into 

your internet browser). After Click on Download, the following window shows, 

Please uncheck all the recommends, and click on No thanks and continue. 

o You can check which version of .NET you have by following the instructions here (if the link 

does not work, paste “http://support.microsoft.com/kb/318785” without the quotes into 

your internet browser). 

• Windows 7 or 8 

o If you’re using Windows 7 or 8, you may be prompted with a security warning whenever you run 

a program. For this setup, allow these programs to run. 

• USB2.0 port (not compatible with USB3.0) 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://support.microsoft.com/kb/318785
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3 Installing the PowIRCenter through Infineon Toolbox 

The Infineon Toolbox is a launcher program that allows a user to install any Infineon program that is 

used for customer designs. The PowIRCenter, among other PMM GUIs, is available through this 

program. To download it, follow the installation instructions below. 

Also, note that the PowIRCenter has 2 operating modes: POL and Multiphase. The POL version does not 

require a license and only allows access to the following part numbers: 

o IR35218 

o IR36021 

o IR38060 

o IR38062 

o IR38063 

o IR38064 

o IR38163 

o IR38164 

o IR38165 

o IR38263 

o IR38265 

o IR38363 

o IR38365 

o IRPS5401 

The Multiphase version is accessible with a valid license file, and allows access to all Infineon 

Multiphase Parts. To get a license file, contact your Infineon FAE or representative. 

3.1. Download and Install Infineon Toolbox 

1. Administrator Access / Administrator Privilege: If you are not logged into an Administrator 

account or your IT policy requires you to request Administrator privilege, you must gain 

Administrator privilege before continuing the installation process. This process is specific to 

your company. Contact your IT representative if you are unsure how to gain Administrator 

privilege. 

2. Go to the Infineon Toolbox webpage by clicking here. 

a. If the link does not work, copy and paste this URL into your browser (Internet Explorer, 

Chrome, Firefox, etc.):  http://www.infineon.com/toolbox

http://www.infineon.com/toolbox
http://www.infineon.com/toolbox
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3. Scroll down to the bottom of the webpage and click “Download Now”. This will begin the 

download for the Infineon Toolbox installer. 

If the option is given, save the file to the Desktop. 

4. Once the file is finished downloading, open it to run the installer. 

a. On the first screen, read the agreement, select “I accept the agreement” if you accept the 

agreement, and click “Next”. 

b. On the second screen, check “Create a desktop shortcut” if you would like a shortcut to 

launch the Infineon Toolbox to be created on your desktop. Click “Next”. 

c. Click “Install”. 

d. Wait for the download and installation to finish. 

e. Make sure “Launch Infineon Toolbox” is checked and click “Finish” 

3.2. Installing the PowIRCenter through Infineon Toolbox 

1. Launch the Infineon Toolbox if it is not already running. 

2. Select “Manage Tools” on the toolbar. 
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3. In the search bar, enter “dcdc” 

4. Scroll down the list until you find “PowIRCenter”. Click the Install button. 
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5. Read through the license agreement, then click “Accept” if you accept it and the installation 

process will begin. 

6. During the installation, you may be prompted for your credentials to install “DPInst64” or 

“DPInst32”. This is the Silicon Labs driver installer, which is required to use the USB005 dongle. 

7. After entering your credentials, click “Next” in the “Device Driver Installation Wizard”. 
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8. Once the Driver finishes installing, click “Finish” 

9. Back in the Toolbox, you will be prompted to restart the GUI. Click “Yes”. 

10. Once the GUI restarts, you will see the PowIRCenter under “My tools”. 

11. Launch the PowIRCenter by hovering over the “PowIRCenter” card and clicking “Start” 
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4 Uninstall PowIRCenter 

1 Hover over the PowIRCenter card and click the trashcan icon  

2 Click “Yes” in the dialog window that appears. 

3 Click “Yes” in the dialog window that appears to restart the Infineon Toolbox GUI. 
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5 Hardware Setup 

The typical setups are shown below. The USB005 dongle has two layers of firmware, the resident bootloader 

layer which will not be modified is responsible for updating and flashing the application firmware. The GUI will 

prompt the user to update the application firmware if the GUI detects the current version is out-of-date. 

CAUTION: the dongle firmware for the PowIRCenter GUI is not backward-compatible with older GUIs such as IR 

DPDC GUI. 

5.1 Firmware Update 

The GUI will prompt the user to update the firmware if there is a newer firmware available. The user has 

the option not to update, but updating is recommended. 

Click Exit after the update. 
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6 Getting Started 

6.1 Launching the GUI - for POL and Multi-Phase Devices 

Multi-phase devices, due to their proprietary technology, are generally restricted and require authorization 

from Infineon to access information and use the devices. 

1. Ask an IFX/IR FAE for IR DPDC License.txt file. Save this file on your Desktop, or some other easily 

accessible location. 

2. In the Infineon Toolbox, go to “My Tools” and mouse over the PowIRCenter card. If an update is 

available, click “Update”, then restart the GUI when prompted. 

3. Once the Infineon Toolbox has restarted, mouse over the PowIRCenter card and click “Start” to 

launch the GUI. 
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4. Once the GUI has launched, go to the “Help Menu  Activate License” and navigate to your IR 

DPDC License.txt. Select it and click “Open”. 

5. Once the file is successfully loaded, you will be prompted to restart you’re GUI. Relaunch the GUI as 

in Step 3 and you can now continue using the program. 
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7 Main Screen Interface 

1. Menu 

2. Board level commands and utilities 

3. Device manager 

4. Common area for system status, register map, PMBus command and summary 

5. USB connection status. 

6. Dongle hardware part number 

7. Dongle firmware version 

8. I2C/PMBus speed 

9. License expiration days left 

10. PMBus Online/Offline Mode 

a. Only adjustable in when using PMBus in Acadia, Manhattan, and Rocky. 

11. GUI status and message 
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8 Device Manager 

8.1 Tree View Structure 

Device manager is a three level tree view structure - board level, device level, and loop level. The board level is 

the root or board design, it cannot be deleted. When you add a new device, it will be attached under the board. 

Depending on the number of loops and PMBus capability, the loop level will be automatically created under the 

device. In the example below, selecting Manhattan IR38063 adds 1 loop and Rocky IRPS5401 adds 5 loops. 

8.2 Dot Colors 

The colored dot in the device manager has different meaning. 

Board Level: 

Device Level: 

Loop Level: 
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8.3 Add/Delete Devices 

To add a device, right-click the Device Manager and select a device under Add Device. 

To delete a device, right-click the device in the Device Manager and select Delete Device. 

8.4 Move Device Up/Down 

1. Click the device to be reordered 

2. Right click on Device Manager then click Move Device Up or Move Device Down

8.5 Editing Tree View Text and I2C/PMBus Address 

1. Click the device or loop to be edited 

2. Right click on Device Manager then click Edit Text/Address
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8.6 Expand/Collapse Device Manager Tree View 

A button in the Menu Bar controls this function:  

Click it once to collapse the Device Tree. 

Click it again to expand the Device Tree. 



Application Note 18 <Revision 1.8>  

<2019-01-02>  

PowIRCenter Installation and User Guide

9 New/Open/Save Board Designs 

A Board Design File contains all the information for a board design, such has the number of devices, the family 

of each device, its load model, and its configuration file information. The GUI requires this information to 

accurately model the device’s behavior. 

Click this icon to start a new board design. This will clear all devices from the Device Tree. 

Click this icon to open an existing board design from a file. 

 Click this icon to save the current board design to a file. 
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10 System Status 

Clicking the board level in the device manager will show all devices vital data in a series of “status meters”. 

Here is an explanation of a status meter’s display: All data displayed here is read from the controller. 

1. Device title text copied from the tree view 

2. Loop title text copied from the tree view – Green = Normal; Orange = PMBus Alert; Red = Fault 

3. Vin – input voltage 

4. Iin – input current (where applicable. Not all devices measure Iin.) 

5. Vcc – IC bias supply (typically 3.3V) 

6. Vout 

7. Iout total current 

8. Temperature 

9. Loop Power on/off indicator – Green = loop on; Grey = loop off 

If the loop has faults, move the mouse cursor to the loop title area to make the fault details appear. 
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11 Clear Faults  

Clicking the clear faults icon will clear all alarms or fault registers if the faults conditions are corrected. 
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12 Auto Populate Devices 

This utility scans the PMBus and populates the GUI with all devices found.  
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13 Read Registers from Devices  

This utility reads all registers of all devices and updates the GUI. The user should perform the read registers 

operation after adding devices or auto populating devices. 
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14 Device Level - Register Map (in “Full” PowIRCenter only) 

Click a device in the device manager to bring up the register map of the device. You can load/save the 

configuration file or read/write registers. 

1. Register Map tab 

2. Design Tools tab – Contains tools to configure control registers 

3. Utilities tab – Contains tools to assist system or board design 

4. Tree view. Click to select a register. 5 – 9 are associated with tree view. 

5. Tree view register description 

6. Tree view register value (for reading or writing) 

7. Tree view register value decoded. 

8. Read the tree view register 

9. Write the tree view register 

10. Map view. Click to select a register. 11 – 14 are associated with map view. 

11. Map view register address 

12. Map view register data 

13. Write the map view register 

14. Read the map view register 

15. Read all registers and update register map in area 10 

16. Write all registers in area 10 to the device 

17. Load a configuration file 

18. Save user and manufacture section to a configuration file 

19. Load a standard (preset) configuration file from the provided list. 

20. Register Map Status 
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15 Device Level – Design Tools 
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16 Device Level – Utilities 
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17 Loop Level - PMBus interface 

Clicking a loop in the device manager will bring up the PMBus interface of the loop. You can read/write 

individual PMBus command and monitor all PMBus command values. 

17.1 Command and Summary 

1. Select a PMBus command to read or write from the drop-down list. 

2. Sort the PMBus command list by Command Code. Click again to sort by Command Name. Default is 

sort by Command Name. 

3. Set a new value of the command – this area changes based upon the selected command 

4. Description of the command 

5. Read the selected PMBus command 

6. Write the selected PMBus command with a new value 

7. Toggle to enable or disable Continuous PMBus Command Updates. If enabled, PMBus values will 

update every second. 

8. Update PMBus Command once. If Continuous PMBus Command Updates is enabled, this button is 

disabled. 

9. PMBus commands summary. Clicking any entry in the summary table will change the command in 

the drop-down list.
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17.2 PMBus Status 

PMBus status is updated every second. 

• Red – alarm or fault 

• Black - normal 

• Gray – not supported 
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17.3 Display Basic PMBus Commands (only for Acadia, Manhattan, and Rocky) 

These 3 devices have an option to filter the command list down to a few basic controls. This is selected by 

ticking the “Basic Commands” option at the bottom of the PMBus Page. To view the full list of PMBus 

commands, tick the “All Commands” option. 
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18 Floating Status Window 

When a device or loop is selected, a floating status meter will appear to show all vital data of the device. The 

floating status meter can be placed anywhere on the screen so the status can be monitored as device changes 

or PMBus commands are sent. Click button 10 to minimize the floating meter to the lower left corner:  

Double clicking will bring it back: 

1. Device title text (set in the tree view) 

2. Loop title text (set in the tree view)  

- Green = Normal;  

- Orange = Fault related to PMBus;  

- Red = Fault related to Fail code 

3. Vin – input voltage 

4. Iin – input current (where applicable. Not all devices measure Iin.) 

5. Vcc – device bias voltage e.g. 3.3V 

6. Vout 

7. Iout total current 

8. Temperature 

9. Loop on/off indicator – Green = loop on; Black = loop off 

10. Minimize the status meter 
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19 Group Vout Control  

This interface facilitates using the PMBus GROUP command to turn on/off all devices at the same time. 

1. Select or deselect all loops

2. Assign colors to all loops automatically 

3. List of all loops for Vout control 

4. Device title text 

5. Loop title text 

6. Vout voltage setting 

7. Margin high setting & percentage above 

Vout 

8. Margin low setting &  percentage below 

Vout 

9. Real time voltage display. Updated every 

second 

10. Set Vout voltage using VOUT_COMMAND 

11. Turn on selected devices using 

OPERATION group command 

12. Immediate Turn off selected device using 

OPERATION group command 

13. Soft Turn off selected devices using 

OPERATION group command 

14. Margin voltage high on selected devices 

15. Margin voltage low on selected devices 
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20 Group Sequencing Control  

Sequencing control allows the user to edit TON_DELAY, TON_RISE, TOFF_DELAY, and TOFF_FALL of all loops at 

once and visualize their relationship graphically. 

1. Select or deselect all loops

2. Assign random colors to all loops 

automatically 

3. Select or deselect individual loop 

4. Set color to each Vout trace 

5. Device title text copied from device 

manager tree view. 

6. Loop title text copied from device 

manager tree view. 

7. TON_DELAY setting

8. TON_RISE setting 

9. TOFF_DELAY setting 

10. TOFF_FALL setting 

11. TON_DELAY in graphic 

12. TON_RISE in graphic 

13. TOFF_DELAY in graphic 

14. TOFF_FALL in graphic 

15. Write settings to all the devices on the 

selected bus. 
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21 Multi-Device Programmer  

21.1 Important Note 

• During programming, all devices must be disabled. If the programmer detects that any device is 

regulating, the programmer won’t start. 

21.2 User Interface 

1. Device title text copied from device manager tree view  

2. I2C address copied from device manager tree view. These are chip addresses before programming. 

3. Click to load a configuration file 

4. Select/deselect programming the user section or select/deselect individual device 

5. Select/deselect programming the MFR section or select/deselect individual device 

6. Trim section MTP left 

7. Trim section programming result pass (green) or fail (red). Only used in special applications. 

8. Trim section verification result pass (green) or fail (red). Only used in special applications. 

9. User section MTP left 

10. User section programming result pass (green) or fail (red) 

11. User section verification result pass (green) or fail (red) 

12. MFR section MTP left 

13. MFR section programming result pass (green) or fail (red) 

14. MFR section verification result pass (green) or fail (red) 

15. CRC flags of trim, user, and MFR section after executing Check MTP Left  or Verify operation. 0 = Pass; 

1 = CRC error 

16. Programming log area 

17. Load a production file 

18. Save selected configuration files to a single production file. 

19. Check MTP remaining then update box 6 and 9 

20. Verify selected devices and update box 8 and 11 
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21. Program and verify button 

21.3 Programming Procedure 

1. Click and load individual configuration file of each device or load a production file 

2. Make sure all device i2c communications are good (blue color). If there are any i2c issues, it should 

be resolved before programming unless these devices are excluded from programming. 

3. Click Check MTP Left to make sure there are MTP left. 

4. Check user and MFR section of each device that you wish to configure. 

5. Click Program & Verify

6. Review programming log if there are any failures. 

21.4 Verify Only 

1. Cycle board power 

2. Load board design file 

3. Make sure all i2c communications are good 

4. Click multi-device programmer icon 

5. Click Verify Only button 



Application Note 34 <Revision 1.8>  

<2019-01-02>  

PowIRCenter Installation and User Guide

22 I2C/PMBus Utility 

• ‘Scan i2c’ sends slave addresses from 0x08 to 0x77 (skipping 0x0C because it’s the ARA address) and 

checks if the address is ACKed. 

• ‘Scan PMBus’ sends MFR_ID command from address 1 to 127 and check if any IR controllers respond. 

• Most IR controllers can operate at 400 KHz by default. Some devices can operate at 1MHz, but 1MHz 

operation register has to be enabled. 
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23 Linear Calculator Utility  

The Linear calculator is used to convert between PMBus linear format byte data and real numbers. The 

calculator has two separate conversion interfaces. The top calculator is for two bytes linear format data: 

Exponent = High Byte [7:3] 

Mantissa = High Byte [2:0] + Low byte [7:0] 

Value = Mantissa * (2 ^ Exponent) 
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The bottom calculator is for output voltage related parameters that use VOUT_MODE [4:0] for exponent in 

linear format. 

1. Real value to be converted 

2. Convert real value to mantissa and exponent. Exponent can be preset and will not change during 

conversion. 

3. Convert mantissa and exponent to real value  

4. Mantissa 

5. Exponent 

6. Convert mantissa and exponent format to high byte and low byte 

7. Convert high byte and low byte data to mantissa and exponent format  

8. High byte 

9. Low Byte 

10. VOUT_MODE exponent value of the linear format 

11. VOUT_COMMAND high byte 

12. VOUT_COMMAND low byte 

13. Vout voltage 

14. Convert VOUT_COMMAND high/low byte to Vout voltage based on VOUT_MODE exponent 

15. Convert Vout voltage to VOUT_COMMAND high/low byte based on VOUT_MODE exponent 
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24 File Format 

24.1 Configuration File 

Each device can have its own configuration file, which contains the information required to program the device. 

It can come in 3 formats: 3-Column Configuration File, ATE Configuration File (AKA CRC32 Configuration File), 

and Intel Hex Format.  

The user can save the configuration file by clicking the Device Level of a device, selecting the Register Map tab, 

and then clicking the “Save Config File” button. In the new dialog box, the user can select the configuration file 

format, set the name of the file, and select the location to save the file to. 

To load a configuration file, click the Device Level of a device, select the Register Map tab, then click the “Load 

Config File” button. Find the targeted configuration file and click “Open”. 

3-Column Configuration File (recommended for most users)

This file format uses 3 columns separated by white space, like 00 55 FF. The first part is the register address, 

the second part is the data, and the third part is the mask. Because some register bits like password cannot be 

verified after programming, the mask is used to indicate if the corresponding register bit needs to be verified 

(mask bit = 1) or ignored (mask bit = 0). 

ATE Configuration File

This file format is most commonly used by ATE engineers. The GUI generates data in 3 columns separated by 

white space (similar to the 3-Column Configuration File format), but the data is formatted with hex notation 

and contains a CRC32 for verification purposes. 

Intel Hex Format

This file format was created by Intel as a standard for programming devices, such as microcontrollers. Each line 

contains the following information: 

1. Start Code – Signified by a “:” character 

2. Byte Count – 2 Hex digits, indicating the number of bytes in the data field. We use 10h (16d). 

3. Starting Address – Register Address from which to start programming the data. 

4. Data Type – Data type of the Data Field. We use Hex Data Type, which is represented by “00h”. 

5. Data – The Register Data. Contains 16 2-byte pairs. 

6. Checksum – Checksum calculated across all previous bytes in that line. It’s calculated by summing 

all previous bytes together, taking the LSB, and performing a 2’s complement on that value. 
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24.2 Board Design File 

The board design file contains the complete board design information of all devices. 

1. Register values of all devices 

2. User interface settings 

3. Board design components like inductors, capacitors, resistors, and power stages. 

Some examples of the saved data are: 

Load Model (Capacitors, Inductors, DCR, MOSFETs, Loadline) 

Register Map (Configuration File)  
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25 Troubleshooting 

25.1 Error Message: “The application failed to initialize properly 

(0xc0000135).” 

USBXpress Driver was not installed correctly. 

1. Uninstall the PowIRCenter (See “Section 4: Uninstall PowIRCenter”). 

2. Give yourself Administrator Privileges (if necessary) 

3. Reinstall PowIRCenter (See “Section 3.2 Installing the PowIRCenter through Infineon Toolbox”), 

making sure to run DPInst32 / DPInst64. 

25.2 Error Message: “A Java Runtime Environment (JRE) or Java 

Development Kit (JDK) must be available in order to run Infineon-

Toolbox” 

You may see the following error when trying to install or start up the Infineon Toolbox: 

This is an issue with some computers that already have Java Runtime Environment installed. 

Open a Windows Explorer window and navigate to “C:\Infineon\Toolbox\jre\” 
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Select the folder “jre”, right-click it, and select Copy. 

Navigate up one level by clicking the Up Arrow or by clicking “Toolbox” in the Address Bar. You will now 

be at “C:\Infineon\Toolbox” 
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Right-click and select “Paste” 

Once it is finished copying, try running the Infineon Toolbox again. 

25.3 Error Message: “(.NET) Unable to find a version of the runtime to run 

this application.” 

A version of .NET was not installed, or was installed incorrectly. 

1. Go to StartControl PanelAdd/Remove Programs. Check that you have both of the following 

entries: Microsoft .NET Framework 2.0 & Microsoft .NET Framework 4.0. The Service Pack number 

does not matter. 

2. If one or both are not installed, Framework 2.0 can be found here and Framework 4.0 can be found 

here. Download and install the missing files, then retry running the program. 

3. If they are installed, remove both, then download the install files using the links above. Afterwards, 

reinstall Framework 2.0 first, then Framework 4.0. 

http://www.microsoft.com/en-us/download/details.aspx?id=1639
http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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25.4 Issue: Cannot Communicate with the Chip (I2C / PMBus) 

Check that the GUI can connect to the USB005 dongle. In the bottom left of the GUI, there are three 

status boxes.  

If the left-most cell is red, that means that the GUI and USB005 are not connected. Continue to step 1. 

If the left-most cell is green, but the middle cell reads “HW: USBxxxX” and the right cell reads “FW: 0.0”, this means 

the USBXpress Driver has installed correctly, but you do not have the right driver version in your IR PowIRCenter 

folder. Continue to step 3. 

If the left-most cell is green, the middle cell reads “HW: USB005A”, and right cell does not read “FW: 

0.0”, continue to step 4. 

1. Check that the USB is connected to a port in the back of the computer/laptop or to an externally 

powered USB hub. The reason for this is that in many computers and laptops, the side and front 

USB ports have a reduced power supply. This can cause communication problems in our USB005

dongle. 

2. Check that the USBXpress Driver is correctly installed.  

a. Connect the board to the computer. 

b. Open the Device Manager by clicking Start, right-clicking Computer, selecting Properties,

and clicking Device Manager. 



Application Note 43 <Revision 1.8>  

<2019-01-02>  

PowIRCenter Installation and User Guide

c. Expand the section titled Universal Serial Bus controllers. There should be an entry named 

USBXpress Device. 

If you have the USBXpress Device, go to Step 3. 

If there is not, you will need to reinstall the USBXpress driver. 

d. Navigate to your installation directory (default: “C:\IR PowIRCenter”).

e. Double-click the folder called SiLabsDriver.

f. Double-click the file called “install.cmd”. This will attempt to install the driver again.

3. The next step is to verify that the SiUSBXp.dll is the correct version. 

Note: If you installed the driver through the IR PowIRCenter Installation Package.exe, you should be 

able to detect the dongle by this point. If you are still having issues, contact an IR/Infineon 

representative who will be able to assist you. 

a. Navigate to your IR PowIRCenter installation directory (default: “C:\IR PowIRCenter”). 

b. Find the file named SiUSBXp.dll in the directory. 

c. Rename it to “SiUSBXp.dll_backup”. 

d. Open a Windows Explorer window and navigate to “C:\SiLabs\MCU”. 

e. Double-click the folder named “USBXpress_SDK” 

i. If this folder does not exist, double-click the folder named “USBXpress” instead. 

f. Double-click the folder “Examples” 

g. Double-click the folder “CP210x” 
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h. Double-click the folder “Windows” 

i. There should be a file named “SiUSBXp.dll” in this folder. Copy it to your IR PowIRCenter

installation directory. 

j. Relaunch the GUI and check if the left-most cell is green, the middle cell reads “HW: 

USB005A”, and right cell does not read “FW: 0.0”: 

If it looks like the above picture, continue to step 4.  

If it does not, contact an IR FAE who can help you. 

4. Click the Auto Populate Device button in the top left. 

This will scan the bus for any IR parts. If they are detected, they will automatically appear in the left 

hand column. 

If nothing appears, continue with the steps below to debug the issue. 

a. Check that 3.3V power to the IR controller is connected properly and that the supply is on. 

b. Check for proper SDA, SCL, & GND connections between the USB005A and the I2C Header

on the Board under Test. 

c. Check that the address is correct. To scan for the address of the device under test, click the 

I2C Bus button. 
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In the window that appears, click the “Scan I2C/PMBus Address” button.

This will scan the bus for any IR parts (skipping over any reserved addresses such as 0x0A). If any parts are 

detected, they will appear in the window above: 

If the part number is not correct, it will appear as an unknown device: 

5. The I2C cable between the USBI2C Board and the I2C Header on the Board under Test should 

be short (i.e., 20cm or less) and the SDA, SCL, & GND lines twisted together. 
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25.5 Issue: Text is misaligned or “floats”

This issue is caused by how Windows handles Text Magnification at Medium (125%). This can be fixed by 

switching to Smaller (100%) or Larger (150%). 
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1. Right-click your desktop and select “Personalize” 

2. In the bottom-left corner, click “Display” 
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3. You should see 3 options: Smaller – 100%; Medium – 125% (default) ; Larger – 150% 

4. Select either Smaller or Larger, then click “Apply”. This will resize everything on your display.  

25.6 Issue: PowIRCenter is extremely slow with the dongle plugged in.

This issue is most likely caused by plugging the dongle into a USB 3.0 port (blue socket). The problem is a bug in 

the USBXpress Driver and can only be resolved by plugging the dongle into a USB 2.0 port (non-blue socket). 

25.7 Issue: GUI cannot detect devices on the bus, or Autopopulate feature 

does not work

There are a few possibilities for this issue:  

The USB005 dongle is plugged into a USB3.0 port. 

1. Unplug the USB005 dongle if it is plugged in. 

2. Check that dongle connector is not blue. If the port is blue, this indicates that it is a USB3.0 port. 

3. Plug the dongle into a non-blue, USB2.0 port (these are often white or yellow). 

The device or devices are not powered. 

1. Check that each device is receiving 3.3V on the Vcc pin. 
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25.8 Issue: PowIRCenter design file (.pcd) vs. Multi-Device Programmer 

production File (.pdc) 

These two file format may be confusing due to their similar extension name. 

• .pcd file is the PowIRCenter design file. It can be opened from File->Open Board Design… for loading 

the board properties into the GUI, so that the design tool and utilities can be used to configure devices. 

• .pdc file is the production file. It can be loaded from Multi-Device Programmer for board programming 

purpose. 

To load a production file, please follow the steps as below: 

1. Connect dongle and board. 

2. Click on Auto-Populate     to generate all the devices on the Board to the device tree. 

3. Click on Multi-Device Programmer  to launch the programming tool. The device list should be 

automatically populated as below, 

4. Click on Load Production File at the left lower corner to load .pdc file. 

The linked image cannot be  
displayed.  The file may have  
been moved, renamed, or  
deleted. Verify that the link  
points to the correct file and  
location.
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25.9 Issue: Customized device/loop text in the GUI 

Device and loop texts can be changed and saved in the PowIRCenter design file (.pcd) for user’s 

convenience.  

There are two ways to achieve this: 

1) Change from the GUI. 

a) Right click on the device in the device tree and click Edit Text/Address from the dropdown menu 

b) With the CombinedAddressEditor, user can edit the I2C/PMBus addresses and also device and loop 

texts. 

c) After going through changing for each device, the board status and device tree will present the 

updated text. 

d) Click on File->Save Board Design… The loop/device text changes will be saved into the design file. 
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2) Change directly from board design file (.pcd) 

a) Open the board design file and search for “LoopText” or “DeviceText” to change them. Save after 

finished. 

b) Load the changed board design file into GUI. 

NOTE: Device/loop text information are only stored in board design file (.pcd), not in single configuration file (.txt). 
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Revision History 

Major changes since the last revision 

Page or Reference Description of change 

1.1 • Exposed the link for Microsoft .NET v4.0 

• Exposed the link for Microsoft Help Documentation on how to find out your version of .NET 

• Exposed the link to log into the IR FTP server. This allows the user to copy/paste the address if the 

link does not work. 

• Changed the picture for the IR PowIRCenter Installation Package. 

1.2 • Added Troubleshooting section. This should help handle frequently asked questions and issues.

1.3 • Updated Installation Guide to reflect USBXpress v4.0 and new Installation Flow 

• Added Issue: Text is misaligned or “floats” to Troubleshooting section, per Ramesh 

Balasubramaniam’s request. 

• Added Issue: PowIRCenter is extremely slow with the dongle plugged in.

• Fixed references to USBXpress driver. 

1.4 • Added steps to the Installation Guide to deal with IT policies.

1.5 • Changed the process of downloading IR PowIRCenter 

• Added Issue: Unable to download updates due to proxy servers requirement

• Added description for loop text background color orange. 

• Added solution to Microsoft Recommends when downloading Microsoft .NET Framework 4.0. 

1.6 • Added installation instructions for standalone (POL) version 

• Clarified the instructions on some of the steps. 

• Updated the Table of Contents to reflect page changes 

• Updated the footer date to 2016. 

• System requirements are: Win 7, 8 + USB2.0 (not compatible with USB3.0) 

• Troubleshooting: Autopopulate difficulties: check if using USB3.0 port and switch to USB2.0 port 

1.7 • Added Issue: PowIRCenter design file (.pcd) vs. Multi-Device Programmer production File 

(.pdc)

• Added Issue: Customized device/loop text in the GUI

1.8 • Changed the Installation Procedure to take into account the new flow with the Infineon Toolbox 

and the removal of the FTP server. This affects Section 3, 4, and 6. 

• Removed a few Troubleshooting items related to the new flow that are no longer applicable 

because the FTP server will be shut down. 

• Added a Troubleshooting item related to missing Java Runtime Environment 
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